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Preface 

The purpose of this manual is to provide the information needed to use the latest 
enhancements to the CMET functionality available in the iCare (BQI) population 
management application. 

This manual contains reference information about iCare views, examples of its 
processes, and step-by-step procedures to demonstrate how to perform activities 
related to CMET in the latest version of the iCare application. 

For more information about iCare basic functionality, iCare usage, or training for 
iCare consult these resources: 

• iCare – IHS OIT 
Available at http://www.ihs.gov/icare/ 

• iCare Population Management GUI, User Manual Version 2.2 (July 2011) 
available at  http://www.ihs.gov/RPMS/PackageDocs/bqi/bqi_022u.pdf  

• iCare Training available at 
http://www.ihs.gov/icare/index.cfm?module=dsp_icare_cmet_training 

Recorded AdobeConnect sessions for iCare available at 
https://ihs.adobeconnect.com/r6yazmoz1gm 

• Join the iCare listserv by sending an e-mail to icare@listserv.ihs.gov 
 

 

http://www.ihs.gov/icare/
http://www.ihs.gov/RPMS/PackageDocs/bqi/bqi_022u.pdf
http://www.ihs.gov/icare/index.cfm?module=dsp_icare_cmet_training
https://ihs.adobeconnect.com/r6yazmoz1gm
mailto:icare@listserv.ihs.gov
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1.0 Introduction 
iCare is a Windows-based, client-server graphical user interface (GUI) to the IHS 
Resource and Patient Management System (RPMS). iCare retrieves key patient 
information from various components of the RPMS database and brings it together 
under a single, user-friendly interface. iCare is intended to help providers manage the 
care of their patients. The ability to create multiple panels of patients with common 
characteristics (e.g., age, diagnosis, community) allows users to personalize the way 
they view patient data. 

For more information about iCare basic functionality, iCare usage, or training for 
iCare, you can consult the resources listed above in the Preface. 

1.1 Background 
Along with the rest of the healthcare industry, IHS has already developed a set of 
chronic condition management (or register) applications, including for diabetes, 
asthma, and HIV. This type of application provides a way for healthcare providers to 
manage a specific group (register) of patients for a single disease state. Register 
management applications assist healthcare providers to identify high-risk patients, 
proactively track care reminders and health status of individuals or populations, 
provide more standardized and appropriate care by embedding evidence-based 
guidelines, and report outcomes. 

Many patients, however, have more than one diagnosed disease. For instance, at the 
current time within the Indian Health system, a diabetic asthmatic woman could be a 
member of four RPMS registers (diabetes, asthma, women’s health, and 
immunizations). This ‘silo’ approach to patient care could potentially result in 
fragmented care, and could increase the risk of inadequate patient care management 
due to misidentification of the true level of risk. 

1.2 iCare Graphical User Interface 
The iCare GUI is intended to allow providers to see a more complete view of patients 
with multiple conditions, while maintaining the integrity of the user-defined, disease-
specific registers. 

iCare can help IHS providers by: 

• Proactively identifying and managing different groups (populations) of patients 
who share user-defined characteristics. 

• Providing an integrated view of a patient’s conditions that would minimize “stove 
piped” care management. 
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• Providing an intuitive and integrated interface to the diverse patient data elements 
of the RPMS database. 

• Facilitating providers a review of clinical quality of care measures for their own 
patients to enable improvement in the quality of healthcare delivery. 

• Enabling views of traditional healthcare information from the perspectives of 
community, population and public health. 

• Providing the default tag selection as Proposed and Accepted. You can change the 
tag selection for any record by selecting or de-selecting any checkbox. 

• Clicking the “use AND?” check box when there are multiple tags selected. The 
“And” option searches for patients who have ALL of the user-defined tags. 

1.3 Who Should Use iCare? 
Any provider who needs to identify a group of patients for long-term management or 
to create a temporary list should think about using iCare. Do you fit any of the 
following scenarios? 

• I am a nurse at a facility that assigns a primary care provider to each patient. 
Every day, I want to create a list of scheduled patients for two different doctors in 
my clinic. 

• I want to identify which of my patients are considered obese so I can recommend 
nutrition counseling. 

• Because providers at our clinic have performance goals related to annual GPRA 
clinical measures, I want to identify which of my patients are missing key clinical 
data. 

• Our Women’s Health Clinic wants to focus on two clinical performance 
improvement initiatives this year. We want to identify the performance problem 
areas for female patients between the ages of 18 and 50. 

• I am one of two part-time case managers for a group of children, and I want to 
create a patient list that we both can use. 
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2.0 Orientation 
This section provides an overall look at the design and functions of the main screen 
elements of the iCare interface. 

The core concept of iCare is the patient panel. This panel is a list of patients that the 
user has defined, either manually by selecting individual patients or by using 
automated search definitions. 

2.1 iCare Windows Overview 
The iCare main window will display the namespace and RPMS Server Address. This 
aids those larges sites with multiple servers. The user can quickly review what server 
and namespace are being accessed. 

 
Figure 2-1: Sample namespace and RPMS server address information 

2.1.1 iCare Main Window 
The iCare Main window contains two lists, which can be displayed on separate tabs 
or viewed on a split screen as well as the following: Community Alerts, National 
Measures, CMET, and IPC. 

2.1.1.1 About the Panel List 
The Panel List is displayed in columnar format. It contains a list of all the panels that 
have been defined by you or that have been shared with you by another user. 

 

Figure 2-2: Sample Panel List 

2.1.1.2 About the Flag List 
The Flag List is displayed in columnar format. It displays flags for any patient on any 
of the panels in the Panel List, including shared panels. 
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Figure 2-3: Sample Flag List 

2.1.1.3 About Community Alerts 
The Community Alerts view is displayed in columnar format. It contains alerts 
associated with the patient’s Community of Residence (COR). 

 
Figure 2-4: Sample Community Alerts View 

2.1.1.4 About National Measures 
The Nat’l Measures tab displays IHS national clinical performance measure as 
defined and reported in the RPMS Clinical Reporting System (CRS). iCare uses CRS 
performance logic to display whether the patients in the facility are meeting annual 
performance goals. 

 
Figure 2-5: Nat’l Measures window 
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2.1.1.5 About CMET 
The CMET view is displayed in three sub-tabs: Events, Tracked Events, and 
Follow-up Events. 

 
Figure 2-6: Sample CMET view 

2.1.1.6 About IPC 
The IPC view is displayed on several sub-tabs: Patient Detail, Panel Detail, 
Provider Aggregated, and Facility Aggregated. 

 

Figure 2-7: Sample IPC view 

2.1.2 About the iCare Panel View Window 
The Panel View displays a list of the patients in a particular panel. 
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Figure 2-8: Sample Panel View window 

2.1.3 About the iCare Patient Record Window 
The Patient Record window displays information about the selected patient from data 
stored in the RPMS database. 
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Figure 2-9: Sample Patient Record window 

2.2 Key iCare Concepts 
This section discusses diagnostic tags, taxonomies, and national performance 
measures. 

2.2.1 Diagnostic Tags 
iCare provides a diagnostic tagging function that runs as a background process on 
your RPMS server and reviews all patient data. Tagging is a term that refers to 
running a series of logic algorithms on one or multiple patients that identifies (“tags”) 
them with one or more predefined diagnostic categories, listed below. 

• Asthma 

• COPD 

• Cardiovascular Disease (CVD) Known (CVD Kn) 

• CVD At Highest Risk (CVD AHR) 

• CVD At Significant Risk (CVD ASR) 

• CVD At Risk (CVD AR) 

• Diabetes (DM) 
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• HIV/AIDS (HIV) 

• Hypertension (HTN) 

• Obese 

• Prediabetes/Metabolic Syndrome w/o DM (PreDM) 

• Current Smokers (Smoker) 

• Pregnancy 
One patient might have multiple diagnostic categories, e.g., diabetes, asthma, and 
known cardiovascular disease (CVD). The overall purpose of the diagnostic “tag” is 
two-fold: (1) to enable iCare to quickly create a panel for a user based on the same 
categories and (2) to enable application of fully integrated healthcare reminders that 
reflect the prevention and treatment priorities for the full spectrum of a patient’s 
disease conditions. 

2.2.2 Taxonomies 
RPMS clinical applications, including the Diabetes Management System, the Clinical 
Reporting System, the PCC Health Maintenance Reminders, and iCare contain logic 
(artificial intelligence) statements that compare and calculate various types of patient 
data to arrive at a conclusion. 

For example, in order for a Pap Smear Reminder to appear on the Health Summary, 
RPMS has to calculate the following about the patient: 

• Is the patient a woman? 

• If yes, does she fall into a certain age range? 

• If yes, was a pap smear ever performed? 

• If yes, what is the date of the most recent pap smear? 

• If the most recent test is overdue, a reminder needs to appear 
To produce results with comparable data across every facility, the clinical definition 
of a “pap smear” has been defined nationally. Clinical definitions use RPMS 
taxonomies to contain the various elements of a definition. As much clinical logic as 
possible is based on standard national codes, including ICD, CPT, LOINC, NDC, and 
national IHS standard code sets (e.g., Health Factors, patient education codes, etc.). 
For terminology that is not standardized across each facility, such as lab tests or 
medications, RPMS uses taxonomies that can be populated by each individual facility 
with its own codes. 
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For data elements like diagnoses, procedures, or lab tests identified by LOINC codes, 
the taxonomy simply identifies the standard codes that a software program should 
look for. These codes are hard-coded by the programmer into several software-
defined taxonomies that are distributed with the RPMS software that uses those 
taxonomies. These taxonomies can only be updated by the software programmer at 
the direction of a national clinical logic review process. 

Site-populated taxonomies are used to mitigate the variations in terminology for 
other types of data elements that vary from one facility to another, including 
medications and lab tests. This means, for example, that one site’s Pap smear data can 
be compared to another site, even though the same term is not used for the Pap smear 
lab test. Or, one site’s beta-blocker data can be compared to another site, even though 
the same names are not used for beta-blocker drugs. 

For example, one site’s Lab table might contain the term Glucose Test while another 
site’s table might contain the term Glucose for the same test. PCC programs have no 
means for dealing with variations in spelling, spacing, and punctuation. Rather than 
attempting to find all potential spellings of a particular lab test, the application would 
look for a pre-defined taxonomy name that is installed at every facility. The contents 
of the taxonomy are determined by the facility. In this example, the application would 
use the “DM AUDIT GLUCOSE TESTS TAXONOMY.” The individual facility will 
enter all varieties of spelling and punctuation for Glucose Tests used at that particular 
facility. 

2.2.3 National Performance Measures 
Performance assessment measures what an organization does and how well it does it. 
For a healthcare organization, such as the Indian Health Service, this means 
measuring how well we deliver healthcare services to our population, measured by 
documentable improvement in various standard health measures. Standardized 
clinical performance measures provide a systematic approach to health improvement 
for our organization. Results from performance assessment are used internally within 
the IHS, at national and local levels, to support and guide performance improvement 
in those clinical areas that need it. 

Additionally, the Government Performance and Results Act (GPRA) requires federal 
agencies to report annually to Congress on how the agency measured up against the 
performance targets set in its annual plan. IHS GPRA measures include measures for 
clinical prevention and treatment, quality of care, infrastructure, and administrative 
efficiency functions. The RPMS Clinical Reporting System (CRS) is the reporting 
tool used by the IHS Office of Planning and Evaluation to collect and report clinical 
performance results annually to the Department of Health and Human Services 
(DHHS) and to Congress. 
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2.2.3.1 Clinical Reporting System (CRS) 
The Clinical Reporting System (CRS) is an RPMS software application designed for 
national reporting as well as for local and area monitoring of clinical GPRA and 
developmental measures. CRS was first released for FY 2002 performance measures 
(as GPRA+) and is based on a design by the Aberdeen Area (GPRA2000). 

Each year, an updated version of CRS software is released to reflect changes in the 
logic descriptions of the different denominators and numerators. Additional 
performance measures might also be added. Local facilities can run reports as often as 
they want to and can also use CRS to transmit data to their area. The Area Office can 
use CRS to produce an aggregated area report for either annual GPRA or Area 
Director Performance reports. 

2.2.3.2 Performance Measures Displayed in iCare 
iCare uses exactly the same logic as the Clinical Reporting System to display results 
for national performance measures. Results can be seen for either a panel of patients 
or an individual patient. iCare also displays aggregate national measures data for the 
site’s active population for all National Measures. 

2.2.4 Reminders Displayed in iCare 
The Reminders view is similar to the National Measures view. The values in the 
individual reminders columns will be the due date of the test/procedure. Active 
reminders are reminders that are “turned on” at the site.  

The patient panel has a separate Reminders Aggregate view that displays aggregate 
reminders performance data for the panel population for all national health 
maintenance reminders that are active at the site. 
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3.0 CMET 
The Care Management Event Tracking (CMET) tab on the iCare main window 
provides information on Events, Tracked Events, and Follow-up Events sub-tabs. 

 
Figure 3-1: Sample CMET tab 

The data on the various sub-tabs are for those patients with an active HRN (Health 
Record Number). 

The CMET tab displays the statuses of particular tests/procedures/exams on the 
various sub-tabs. The term “event” refers to what needs to be completed, for example, 
Breast Exam. 

• These events are listed by category: Breast, Cervical, Colon, Skeletal, STI. 

• The events apply to female and male patients. 
If two users are working on the same CMET record, the changes that are saved first 
will be applied. A message to the second user is provided: This record has just been 
updated. Do you want to refresh the entire list? Click Yes to refresh (otherwise, click 
No). 

Consider the following information: 

When using the Startup View tab of User Preferences, you select the startup view 
you would like to see when opening iCare. If you select the CMET radio button on 
User Preferences, there will be a secondary field. Use this secondary field to define 
the default sub-tab, for example, Tracked Events. If you select the Layouts tab on 
User Preferences, you can select the default template for the various CMET sub-
tabs. 
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3.1 CMET Reminders Workflow 
When events are mined via the iCare background job, they show up in the Pending 
queue, Events tab, for evaluation to determine if the event was positive or negative.   

 
Figure 3-2: Sample Result detail and CMET Events tab row highlighted 

An event with a negative result should be tracked in order to indicate that it has been 
reviewed, has been verified, the patient has been notified and a follow up procedure 
has been identified.  For negative pap smears and mammograms, multiple events can 
be batch processed because there is a set follow-up – another pap or mammogram in a 
defined timeframe; e.g., 1 year, 2 years, etc. 
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Figure 3-3: Sample multiple selection and Batch Process detail screens 

Follow-up Events become CMET Reminders when the iCare Nightly Job runs (or an 
iCare user accesses a patient’s Reminders tab in the iCare Patient Records and 
recalculates the Reminders for the selected patient) and can be “due” in the future or 
“overdue”. 
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Figure 3-4: Sample CMET Follow-up Events view with overdue events 

iCare users can then create an iCare panel based on the PAP SMEAR (CMET) 
reminder for upcoming or overdue reminders and follow the normal process for doing 
Reminder Notifications from the Panel View – Definition Details tab. 
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Figure 3-5: Sample Panel Definition Filter view with CMET Reminder due selected 
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4.0 CMET Layout 
This section describes the sub-tabs for the CMET main window. 

4.1 Events Sub-Tab 
The Events sub-tab displays all events that have been identified at your site in the 
routine background job. This can be a very large number of events, but you can limit 
this display by applying filters to your view. Filtering in this manner does not affect 
the routine background job. 

 
Figure 4-1: Sample Events sub-tab 

Events are procedures, screenings, and/or exams that have been pre-defined and 
categorized into Breast, Cervical, Colon, Skeletal, and STI. The occurrence of these 
events is searched for during a routine background job at your site. The most recent 
occurrence of any event within a certain time period is then placed on the Events tab 
where users can elect to either track or not track the event, or leave it in a pending 
status indefinitely. Once “Tracked,” a CMET is established. 
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The information on this sub-tab is divided into three general areas: Tips information, 
Events data, and Filter area. 

The Tips information provides an overview of the sub-tab. You can collapse this 
information in order to have more room for viewing the Events data. 

The Filters area provides filters for applying filter criteria to the events data. You can 
collapse this area in order to have more room for viewing the events data. 

Note: You can establish the default “collapse” status for the Tips 
and Filters areas on this sub-tab. To do that, select Tools | 
User Preferences | CMET tab | Events sub-tab. The 
checkboxes on this sub-tab will establish the “collapse” 
status. 

The default filters are established on the CMET tab (Events sub-tab) of user 
preferences. These filters are: Category, Status, Time Frame, and Community. 
Section 6.1 provides for more information about these filters. 

You can (also) filter the columns on the Events sub-tab. This is a temporary filter and 
will be lost once you exit the application. 

The initial Data Mining will return the most recent occurrence of every event found 
with an established timeframe. These events are displayed on the Events sub-tab. 
Section 6.9.1 provides for more information about the timeframes. 

4.1.1 Filter Group Box 
Use the filter features shown in the Filters group box. This means you can filter the 
events by using one or more of the following: Category, Status, Time Frame, 
Community. Then, you must use the Get Events button to re-display the events. 

Get Events: If you change the filters in the Filters group box, click the Get Events 
button to update the display. 

Save: After you have changed the filters using the filter features in the Filters group 
box and you want these to be the default filters, click Save. This means those filters 
will be in effect when you use iCare in another session. This action changes the filters 
in User Preferences (on the CMET tab). 

Restore to User Pref: If you used the CMET filter features in the Filters group box 
and you want to return to the last-saved CMET filters in User Preferences, click the 
Restore to User Pref button. 

4.1.2 Events Sub-Tab Layout 
The data on the Events sub-tab is current as of the date/time on the toolbar. 
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Figure 4-2: Sample Columns on Events sub-tab 

The following table provides information about the columns on the Events sub-tab. 

Column Name Meaning 
Category The name of the category for the event: Breast, Cervical, Colon, 

Skeletal, STI. 
Patient Name Required field and will link to the Events sub-tab of the CMET tab on 

the Patient Record if you double-click on it. 
HRN Patient’s Health Record Number. 
Sex F (for female) or M (for male) 
Age Patient’s age today. 
DOB Patient’s date of birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this 

field to empanel patients. 
Community Patient’s community of residence. 
Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed for 

this patient, based on the tagging function (Proposed or Accepted). 
Event Name The name of the event. Events are procedures, exams, or tests that 

have been documented in RPMS. Events are predefined. 
Event Date The date associated with the event. 
Result The date of the result of the event. This cell also has hover help, 

such as V Radiology. 
Status The status of the event: Pending, Superseded, Tracked, or Not 

Tracked. 
Status Comments Text of the any comments about the status. 
Last Modified 
Date/Time 

The date the event was last modified 

Last Modified By The name of the person who last modified the event (in some cases 
it will read: Initial job). 
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The default sort order is: Category, Date of Event (newest listed first), Patient Name 
(in alphabetical order). 

If a Community cell contains the Community Alert ( ) icon, you can view the 
Community Alert text by hovering your mouse over the icon. The icon does not affect 
the sorting of the Community column. 

You can view the CMET - Visit Detail pop-up for any underlined date in the Event 
Date column by double-clicking the date. 

You can view a particular detail pop-up for any underlined date in the Result column 
by double-clicking the date. 

If there exists an older event with a status of Pending and a new event comes in, the 
application changes the status of the older event to Superseded. You cannot track this 
type of event. 

4.1.3 Buttons on Events Sub-Tab 
Please consider the following: 

In order to view an event status, change the Status field in the Filters group box. For 
example, if you changed the status of an event to Tracked, you would change the 
Status to Tracked (or All) and then click Get Events. 

4.1.3.1 Track 
The Track function requires the iCare Editor (BQIZCMED) security key. Select one 
or more events with a status of Not Tracked or Pending and then click the Track 
button (or select Track on the context menu). 

Once an event has been Tracked, it cannot be changed to Not Tracked. If the 
particular event was changed to Tracked and that is not correct, you need to go to the 
Tracked tab, then access the CMET worksheet for the event you tracked in error. 

If you select events that are not eligible for the Tracked function, the application 
displays the message: Events having a status of Tracked can’t be changed to Tracked. 
Click OK to dismiss the message. 

If you select only one eligible event, the application displays the RPMS iCare - 
Track - Findings Due Date dialog. 
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Figure 4-3: Sample RPMS iCare - Track - Findings Due Date dialog 

If you selected more than one eligible event, the application displays the RPMS 
iCare - Track - Findings Due Date dialog (for multiple events). 

 
Figure 4-4: Sample RPMS iCare - Track - Findings Due Date dialog for multiple events 

In either case, do the following: 

• Make sure that the correct date is in the Findings Due Date field (required). If you 
need to change it, click the drop-down list to access a calendar (where you can 
select another date). The date cannot be earlier than the current date. 

• Type the text of the reason for changing the status to TRACKED in the Free Text 
field (not required). 

• Click Save to save the information (otherwise, click Cancel to not save). When 
you use Save, this changes the status of the events to Tracked. These events will 
display on the Tracked events sub-tab of the main window. 

If you use the Save and Enter Findings button for a single event, the application 
displays the CMET Worksheet (where you can add Findings to the event, for 
example). Section 4.4 provides for more information about the worksheet. After 
saving the worksheet, you return to the Events sub-tab. 
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4.1.3.2 Don’t Track 
Use the Don’t Track function to change the status of a Pending event to Not Tracked. 
Select the events and click Don’t Track (or select Don’t Track on the context 
menu). 

If you select Tracked events, they are not eligible for the Not Tracked function. In 
this case, the application displays the message: Once an event has been Tracked, it 
cannot be changed to Not Tracked. See the User Manual guidance on how to manage 
an event that was tracked. Click OK to dismiss the message. If the selected Tracked 
event was erroneously tracked in error, section 4.5 provides for more information 
about how to handle this error. 

If you selected eligible events, the application displays the RPMS iCare – Don’t 
Track Event dialog. 

 
Figure 4-5: Sample RPMS iCare – Don’t Track Event dialog 

Type a reason for the change in the Free Text field (not required). Click OK to save 
and to change the Status of the events to Don’t Track. (Otherwise, click Cancel.) 

4.1.3.3 Pend 
Use the Pend function to change the status of a Not Tracked event to Pending. Select 
the events and then click the Pend button (or select Pend on the context menu). 

If you select events that are not eligible for the Pend function, the application displays 
the message: Only events with status of Not Tracked can change to Pending. Click 
OK to dismiss the message. 

If you selected eligible events, the application displays the RPMS iCare – Pend 
Event dialog. 



iCare Population Management GUI (BQI) Version 2.5 

CMET User Manual CMET Layout 
June 2016 

22 

 
Figure 4-6: Sample RPMS iCare – Pend Event dialog 

Type a reason for the change in the Free Text field (not required). Click OK to save 
and to change the Status of the events to Pending. (Otherwise, click Cancel.) 

4.1.3.4 Batch Processing 
The Batch Process only applies to screening mammograms and pap smears with 
normal results. This process can be applied to multiple events. Although it can be 
applied to one event, its purpose is to be applied to multiple events. 

The CMET Package Manager sets the parameters for batch processing for the entire 
site. The Batch Process function requires the iCare Editor (BQIZCMED) security 
key. 

The Batch Process works only on events that are Pending. 

• If you selected a mammogram screening or pap smear event that is not Pending, 
the application displays the Invalid selection message: Please select only 
PENDING Events in order to process these as a batch. Click OK to dismiss the 
message. 

• If you have selected an event that is not a mammogram screening or pap smear, 
the application displays the Invalid Selection message: The event type selected is 
not eligible for batch processing. Please reselect. Click OK to dismiss the 
message. 

Select either the mammogram screening events or the pap smear events that you want 
to batch process. Then, click the Batch Process button (or select Batch Process on 
the context menu) to batch process the selected events and to change the Status/State 
to Closed. (The selected events must be of the same type of event, either all 
mammogram screenings or all pap smears.) 

• If you selected the mammogram screening events that are eligible for this process, 
the application displays the CMET Batch Mammogram Screening dialog. 
Section 4.1.4 provides for more information about this dialog. 
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• If you selected the pap smear events that are eligible for this process, the 
application displays the CMET Batch Pap Smear dialog. Section 4.1.5 provides 
for more information this dialog. 

4.1.3.5 Create a Panel 
Use the Create Panel function to create a panel from selected events. The patients 
associated with the events become the patients in the new panel. Select the events and 
then click the Create Panel button (or select Create Panel on the context menu) to 
access the Create Panel dialog. 

 
Figure 4-7: Create Panel dialog 

You can change the name of the new panel in the New Panel Name Free Text field. 

Click OK to create the panel (otherwise, click Cancel). After the create process 
finishes, the application displays a message: Panel created successfully! Click OK to 
dismiss the message. The new panel is listed on the Panel List window. It uses the 
No Predefined Population Search - Add Patients manually population search 
option. 

4.1.3.6 Status of Background Jobs 
To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs ( ) button 

• Select File | Background Jobs 
This displays the RPMS iCare - Background Jobs window. 

4.1.4 CMET Batch Mammogram Screening Dialog 
The batch process for mammogram screenings changes the events to have a Status of 
Tracked, the Event State of Closed, and the Close Reason of Event Complete. 
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Figure 4-8: Sample CMET Batch Mammogram Screening dialog 

After completing the dialog, click OK to save the data on the dialog. (Otherwise, 
click Cancel.) 

4.1.4.1 Fields on Dialog 
The required fields have the asterisk (*) following the name. 

Status: This is the status of the event (view only). 

Event Finding: This indicates the event finding. The drop-down list contains the 
options to populate/change this field. 

Finding Interpretation: This field provides the interpretation of the finding (view 
only). 

Follow-up Event: This is the follow-up event (view only). 

Follow-up In: This is the time frame for the follow-up. The drop-down list contains 
the options to populate/change this field. 
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Notification Type: This is the type of patient notification for the event. Select an 
option from the drop-down list. The options on the drop-down list are defined by the 
application (sites cannot add values). 

Create: The Create button is active when the Notification Type is Letter or Certified 
Letter. This function requires that you have an electronic signature on file. Click the 
Create button to access the Add New TIU Note - Batch Mode dialog. Section 4.6 
provides for more information about this dialog. 

Notification Date: This is the date for the patient notification. The drop-down list 
contains a calendar from which to select a date. 

Event State: This shows the state of the event (view only). 

Close Reason: This is the reason why the status is closed (view only). 

Comment: Use this Free Text field to enter any comments pertaining to the 
mammogram screenings. 

4.1.4.2 Selected Events Group Box 
The Selected Events group box contains the selected patients for batch processing 
(these are the events you selected for the process). This is read-only information. 

 
Figure 4-9: Sample Selected Events group box 

4.1.5 CMET Batch Pap Smear Dialog 
The batch process for pap smears changes the events to have a Status of Tracked, the 
Event State of Closed, and the Close Reason of Event Complete. 
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Figure 4-10: Sample Batch Pap Smear dialog 

After completing the dialog, click OK to save the data. (Otherwise, click Cancel.) 

4.1.5.1 Fields on Dialog 
The fields with the asterisk (*) following the name are required. 

Status: This field displays the status of the event (view only). 

Event Finding: This indicates the event finding (view only). 

Finding Interpretation: This provides the interpretation of the finding (view only). 

Follow-up Event: This displays the follow-up event (view only). 

Follow-up In: This is the timeframe for the follow-up. The drop-down list contains 
the options to populate/change this field. 

Notification Type: This is the type of patient notification for the event. Select an 
option from the drop-down list. The options on the drop-down list are defined by the 
application (sites cannot add values). 
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Create: the Create button is active when the Notification Type is Letter or Certified 
Letter. This function requires that you have an electronic signature on file. Click the 
Create button to access the Add New TIU Note - Batch Mode dialog. Section 4.7 
provides for more information about this dialog. 

Notification Date: This is the date for the patient notification. The drop-down list 
contains a calendar from which to select a date. 

Event State: This shows the state of the event (view only). 

Close Reason: This is the reason when the status is closed (view only). 

Comment: Use this Free Text field to enter any comments pertaining to the pap 
smear screenings. 

4.1.5.2 Selected Events Group Box 
The Selected Events group box contains the selected patients for batch processing 
(these are the events you selected for the process). This is read-only information. 

 
Figure 4-11: Sample Selected Events group box 

4.2 Tracked Events Sub-Tab 
The Tracked Events sub-tab displays all events at your site that have been 
designated as “Tracked” by all CMET users. This can be a very large number of 
events, but you can limit this display by applying filters to your view. Filtering in this 
manner does not affect the routine background job. 
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Figure 4-12: Sample Tracked Events sub-tab 

Findings are abbreviated results and have been pre-defined for each event. Results are 
received and reviewed by the clinician and the appropriate Finding value is entered. 
Multiple Findings can be entered for each Event. Each Finding value has an 
associated, auto assigned Interpretation of either Normal, Abnormal or NA. 

The CMET Worksheet is used to capture CMET activity for individual patients. 

Batch Processing can be used to process multiple patients with normal results for Pap 
Smear or Mammogram Screenings. 

The information on this sub-tab is divided into three general areas: Tips information, 
Tracked Events data, and Filter area. 

The Tips information provides an overview of the sub-tab. You can collapse this 
information in order to have more room for viewing the Tracked Events data. 

The Filters area provides filters for applying filter criteria to the tracked events data. 
You can collapse this area in order to have more room for viewing the tracked events 
data. 
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Note: You can establish the default “collapse” status for the Tips 
and Filters areas on this sub-tab. To do that, select Tools | 
User Preferences | CMET tab | Tracked Events sub-tab. 
The check boxes on this sub-tab will establish the 
“collapse” status. 

The default filters are established on the CMET tab (Tracked Events sub-tab) of 
user preferences. These filters are: Category, State, Time Frame, and Community. 
Section 4.2.1 provides for more information about these filters. 

You can (also) filter the columns on the Tracked Events sub-tab. This is a temporary 
filter and will be lost once you exit the application. 

4.2.1 Filter Group Box (Tracked Events) 
Use the filter features shown under the Filters group box. This means you can filter 
the events by using one or more of the following: Category, State, Time Frame, 
Community. Then you must use the Get Events button to re-display the events.  

The Get Events, Save, and Restore to User Pref buttons work like those on the Events 
sub-tab. 

4.2.2 Tracked Events Sub-Tab Layout 
The data on the Tracked Events sub-tab is effective as of the date/time on the 
toolbar. 

The following table provides information about the columns on the Tracked Events 
sub-tab. 

Column Name Meaning 
Category The name of the category for the tracked event: Breast, Cervical, 

Colon, Skeletal, STI. 
1 - Event The name of the event. Events are procedures, exams, or tests that 

have been documented in RPMS. Events are predefined. 
Event Date The date the event was performed. 
Result The date the result was entered. Hover help will describe where the 

result came from (V-RADIOLOGY, V-LAB). 
2 - Finding(s) Icon that indicates if the event has any Findings. 
Interpretation The interpretation of the selection in the Result field. There is hover 

help for this field, e.g., CMET, that refers to where the interpretation 
was obtained. 

3 - Follow-up(s) Icon that indicates if the event has any follow-up data. 
4 - Patient 
Notification(s) 

Icon that indicates if the event has any patient notification data. 

State The state of the tracked event (open or closed). The default is OPEN. 
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Column Name Meaning 
Patient Name Required field and will link to the Tracked Events sub-tab of the 

CMET tab on the Patient Record if you double-click on it. 
HRN Patient’s Health Record Number (required). 
DOB Patient’s date of birth (required) 
Age Patient’s age today. 
Sex F (for female) or M (for male) 
Community Patient’s community of residence. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this 

field to empanel patients. 
Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed for 

this patient, based on the tagging function (Proposed or Accepted). 
Tracked By The person who tracked the event. 
Tracked When The date the event was tracked. 

 
The use of icons (checkmarks and feathers) on this sub-tab creates a display that 
makes review of the CMET activity simple. 

The Finding(s) cell can contain the following: 

• The “feather” ( ) icon indicates that entry of a Finding is overdue based on the 
tickler time frames. Hover your mouse over the icon to view the Due Date. 

• The check ( ) icon indicates that the Finding has been entered. Hover your 
mouse over the icon to view the Finding Due date and the Finding Value. 

• An empty cell that indicates that a finding has not been entered and is not past 
due. 

The Follow-up(s) cell can contain the following: 

• The “feather” ( ) icon indicates that entry of recommended follow-up is 
overdue based on Tickler timeframes. Hover your mouse over the icon to view the 
Due Date. 

• The check ( ) icon indicates that follow-up has been entered. Hover your mouse 
over the icon to view the Follow-up Date and the Follow-up type. 

• An empty cell that indicates that a decision regarding the Follow-up has not been 
entered and is not past due. 

The Patient Notification(s) cell can contain one of the following: 

• The “feather” ( ) icon indicates that the type of patient notification is overdue 
based on Tickler timeframes. Hover your mouse over the icon to view the Due 
Date. 

• The check ( ) icon indicates that the type of Patient Notification has been 
entered. Hover your mouse over the icon to view the notification date and type. 
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• An empty cell that indicates that the type of Patient Notification has not been 
entered but is not past due. 

Remember that Finding(s), Follow-up(s), and Patient Notification(s) are entered on 
the CMET Worksheet. 

If a Community cell contains the Community Alert ( ) icon, you can view the 
Community Alert text by hovering your mouse over the icon. The icon does not affect 
the sorting of the Community column. 

You can view the CMET -Visit Detail pop-up for any underlined date in the Event 
Date column by double-clicking the date. 

Double-click the underlined date in the Result Date column to access a particular 
detail pop-up, for example, Women’s Health Detail. 

4.2.3 Buttons on Tracked Events Sub-Tab 

4.2.3.1 Reopen 
Use the Reopen function to change a Closed event to Open. Select only one event 
having a State of Closed and then click the Reopen button (or select Reopen on the 
context menu). The application displays the RPMS iCare – Reopen Tracked Event 
dialog. 

 
Figure 4-13: RPMS iCare – Reopen Tracked Event dialog 

Type the reason for changing the state back to Open in the Free Text field (not 
required). When the dialog is complete, click OK to change the State for the event to 
Open. (Otherwise, click Cancel.) 

If you select more than one event and use the Reopen function, the application 
displays the warning message: Please reselect as only one event can be reopened at 
one time. Click OK to close the warning message and select only one event. 
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4.2.3.2 Close 
Use the Close function to change an Open event to Closed. Select the events with a 
State of Open and then click the Close button (or select Close on the context menu). 
The application displays RPMS iCare – Reason for Closing dialog. 

 
Figure 4-14: RPMS iCare – Reason for Closing dialog 

The fields with the asterisk (*) following the name are required. 

Reason: select an option from the drop-down list: Event Complete, Patient Moved, 
Lost to Follow-up, Other (this option requires a comment). 

Comment: this Free Text field is required when the Reason = Other. Type the text of 
the reason. 

When the dialog is complete, click OK to change the State for the selected events to 
Close. (Otherwise, click Cancel.) 

4.2.3.3 Batch Process 
The Batch Process only applies to screening mammograms and pap smears with 
normal results. This process works on Open events that have empty (no ticklers or 
check marks) in the Findings, Follow-up, and/or Patient Notifications columns. 

If you select events that are not eligible for the Batch Process, the application displays 
the message: Please select only Tracked Events without Findings, Follow-ups, or 
Notifications in order to process these as a batch. Click OK to dismiss the message. 

Select one or more eligible events and click the Batch Process button (or select 
Batch Process on the context menu). 

• For mammogram screenings, Section 4.1.4 for more information. 
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• For pap smears, Section 4.1.5 provides for more information. 

4.2.3.4 Open CMET Worksheet 
Select an event and then click the Open CMET Worksheet button (or select Open 
CMET Worksheet on the context menu) to access the CMET Worksheet (for the 
event). Here you can enter Finding(s), Follow-up(s), and Patient Notification(s) for 
the event. Section 4.4 provides for more information about the worksheet.  

Note: This function can be applied to only one event. 

4.2.3.5 Create Panel 
Use the Create Panel function to create a panel from the selected events. The patients 
associated with the events become the patients in the new panel. Select the events and 
then click the Create Panel button (or select Create Panel on the context menu). 

4.2.3.6 Status of Background Jobs 
To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs ( ) button 

• Select File | Background Jobs 
This displays the RPMS iCare - Background Jobs dialog. 

4.3 Follow-up Events Sub-Tab 
The Follow-up Events sub-tab contains events that you determined what you want to 
do for follow-up. This sub-tab displays all of the follow-up events at your site that 
have been generated by all CMET users. This can be a very large number of events, 
but you can limit this display by applying filters to your view. Filtering in this manner 
does not affect the routine background job. 
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Figure 4-15: Sample Follow-up Events sub-tab 

Follow-up is the clinician's recommendation for what the next step will be, whether 
that is routine screening or further diagnostic studies. Multiple recommendations for 
Follow-up can be entered. This recommendation initiates a CMET Reminder. 

The information on this sub-tab is divided into three general areas: Tips information, 
Follow-up Events data, and Filter area. 

The Tips information provides an overview of the sub-tab. You can collapse this 
information in order to have more room for viewing the Follow-up Events data. 

The Filters area provides filters for applying filter criteria to the follow-up events 
data. You can collapse this area in order to have more room for viewing the follow-up 
events data. 

Note: You can establish the default “collapse” status for the Tips 
and Filters areas on this sub-tab. To do that, select Tools | 
User Preferences | CMET tab | Follow-up Events sub-
tab. The check boxes on this sub-tab will establish the 
“collapse” status. 

You can (also) change the filters on the columns on the Follow-up Events sub-tab. 
This is a temporary filter and will be lost once you exit the application. 
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4.3.1 Filters Group Box (Follow-up Events) 
Use the filter features shown under the Filters group box. This means you can filter 
the events by using one or more of the following: Category, Time Frame, 
Community. Then, you must use the Get Events button to re-display the events. 
Section 4.1.1 provides for more information about using the filters. 

The Get Events, Save, and Restore to User Pref buttons work like those on the Events 
sub-tab. Section 4.1.3 provides for more information about this sub-tab. 

4.3.2 Follow-up Events Sub-Tab Layout 
The data on the Follow-up Events sub-tab is effective as of the date/time on the 
toolbar. 

You can sort/filter the columns and perform other functions on the columns. 

The following table provides information about the columns on the Follow-up 
Events sub-tab. 

Column Name Meaning 
Category The name of the category for the follow-up event: Breast, Cervical, 

Colon, Skeletal, STI. 
Follow-up Event 
Name 

The name of the event. This is the recommended follow-up entered 
in CMET. 

Follow-up Event 
Date 

The date of the recommended follow-up. 

Preceding Event This is the date of the preceding event. When you double-click on the 
underlined date, the application opens to the Tracked Events of the 
CMET tab on the Patient Record. The chain of events in the same 
category is revealed. In addition, there is hover help when you move 
your mouse over the date (for example, PAP SMEAR). 

Patient Name This is the name of the patient. 
HRN Patient’s Health Record Number. 
DOB Patient’s date of birth. 
Age Patient’s age today. 
Sex F (for female) or M (for male) 
Community Patient’s community of residence. 

 
If a Community cell contains the Community Alert ( ) icon, you can view the 
Community Alert text by hovering your mouse over the icon. The icon does not affect 
the sorting of the Community column. 

If you double-click any event (not on the Preceding Event cell), the application 
displays the CMET Worksheet for the event. Section 4.4 provides more information 
about the worksheet. 
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4.3.3 Buttons on Follow-up Events Sub-Tab 
The Create Panel, Open CMET Worksheet, and Status of Background Jobs buttons 
work like those on the Tracked Events sub-tab. Section 4.2.3 provides for more 
information about the buttons. 

4.4 CMET Worksheet 
Use the Open CMET Worksheet button to access the CMET Worksheet for a selected 
event on the particular sub-tab of the CMET window. You find this button on the 
Tracked Events and Follow-up Events sub-tab on the CMET main window. 

Use this worksheet to process the Care Management Events that you have chosen to 
track. Enter data related to: Findings, Follow-up and Patient Notification. The Site 
parameters “Due By” default dates set by the CMET Package Manager can also be 
edited in this screen. 

 
Figure 4-16: Sample CMET Worksheet 

When the worksheet is complete, click OK (otherwise, click Cancel). 
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• When you use OK, there are two cases. 
Case 1: if all of the steps are not complete, the application updates the data on the 
Tracked Events sub-tab. 

Case 2: if all of the steps are complete, the application will display the Close 
Event information message that states: The event is eligible for closing as all four 
steps are completed. Do you want to close the event now? Use Yes to close the 
event. Use No to not close the event. 

If you choose to close the event (by selecting Yes on the Close Event message), 
the application displays the RPMS iCare Reason for Closing dialog. Here you 
select a reason for closing the event and provide a comment (required) about the 
closing. Click OK to save the reason for closing (otherwise, click Cancel). 

If you use OK on the Reason for Closing dialog, the application displays the 
“Save to RPMS?” dialog that states: You have data changes pending. Do you 
want to save to RPMS now? Click Yes to save the changes to RPMS. Click No to 
not save the changes. 

• When you use Cancel, there are two cases: 
Case 1: if you did not make any changes on the worksheet, the application closes 
it. 

Case 2: if you did make changes on the worksheet, the application displays the 
“Save to RPMS?” dialog that states: You have data changes pending. Do you 
want to save to RPMS now? Click Yes to save the changes to RPMS. Click No to 
not save the changes. Click Cancel to return to the CMET Worksheet. 

4.4.1 Patient Demographics Group Box 
The Patient Demographics group box shows the patient’s name, HRN, Sex, Age, and 
DOB. 

4.4.2 1 - Event Group Box 
The data in the 1 – Event group box provides information about the event and allows 
you to change the State of the event as well as provide comments about the Event 
and/or State. In addition, you can view the audit history of the event. 

 
Figure 4-17: Sample Event group box 
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State: This field defines the State of the event. 

If you populate the State field with Closed, then the Close Reason field becomes 
active where you select an option from the drop-down list that describes why you are 
closing the event. 

When an Event has a State of Closed, the other group boxes (Findings, Follow-up, 
Patient Notifications) will be inactive. 

Event Comment: Use this Free Text field to add comments about the Event. 

State Comment: Use this Free Text field to add comments about the State. 

CMET Audit History: If you click the View label, the application will display the 
CMET Audit History pop-up. 

 
Figure 4-18: Sample CMET Audit History pop-up 

Because multi-users work on the event, the audit history provides a history of those 
activities. 

State: This is determines the state of the event, either Open or Closed. If “Closed” is 
used, then the Close Reason field becomes active. 

If Closed is used, this causes all of the other group boxes (2 - Findings, 3 - Follow-
ups, 4 - Patient Notifications) to become inactive. 

Close Reason: This field is active when State = Closed. Select an option on the drop-
down list that gives the reason for closing the event. 

4.4.3 2 - Findings Group Box 
Use the 2 – Findings group box to enter Findings data about the event. 
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Figure 4-19: Sample Findings group box 

You can minimize this group box by clicking the collapse button in the upper left 
corner. This allows more room for viewing the other group boxes (Follow-ups and 
Patient Notifications). 

The Findings Due By, Result, and Follow-up Recommended? fields become 
populated when you use the Add button on the grid and save the record. 

Findings Due By: This field displays the date the findings of this event are due. If 
this date passes without an entry, a “tickler” (Feather icon) is generated. 

Result: This field displays the date of the result. If this field contains an underlined 
date, click on the date to display the detail of the result. For example, below is the 
Radiology Case Number Detail pop-up. 

 
Figure 4-20: Radiology Case Number Detail 

Follow-up Recommended?: This field indicates if follow-up is recommended (yes or 
no). 

4.4.3.1 Add Button 
Use the Add button to create a new Findings record. Click the Add button (or press 
the F2 button on the keyboard) to access the Findings dialog. 
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Figure 4-21: Findings dialog 

The field names followed by an asterisk (*) are required. 

Date: Click the drop-down list and select a date for the finding. 

Finding:. This is the finding associated with the event. Use an option from the drop-
down list to populate this field. 

Interpretation: The application populates this field, based on your selection in the 
Finding field. 

Comment: Type the text of the comments about the Finding, if appropriate, in this 
Free Text field. 

Follow-up Needed: Use an option from the drop-down list: Yes or No. 

Click OK to save your data on the Findings dialog (otherwise, click Cancel to not 
save). 

After saving the data, the application populates the grid with the record and populates 
the Last Edited (current logon user) and Last Edited By (current date) columns. 

If you saved and had selected Yes for “Follow-up Needed” field (on the Findings 
dialog), this will cause the “Follow-up Recommended?” field on the grid to be 
populated with Yes and the application will automatically display the Follow-Ups 
dialog (where you can enter follow-up data). 

4.4.3.2 Delete Button 
The Delete function applies to events that had Findings entered but NOT saved. 

If you select an event that is not eligible for the Delete function, the application 
displays the message: Unable to delete a previously saved entry. Please mark as 
‘Entered in Error’ instead. Click OK to dismiss the message. 
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Select one or more eligible Findings records you want to delete and click the Delete 
button (or press the Delete button on your keyboard). The application displays the 
Delete Row information message, confirming the deletion. Click Yes to delete the 
selected records. Otherwise, click NO  to not delete the records. 

4.4.3.3 Error Button 
Use the Error button when Findings records have been saved and you cannot delete 
them and you want to mark them as Entered in Error. 

If you select a record that is not eligible for the Error function, the application 
displays the message: Unable to mark as ‘Entered in Error’ because the entry has not 
been saved in RPMS. Please delete the entry instead. Click OK to dismiss the 
message. 

Select one or more eligible Findings records and click the Error button. After using 
this function, the application places a strikethrough mark on the text of the record. 

 
Figure 4-22: Sample Entered in Error marking 

After you save and return to the Tracked Events tab, the Result column for the event 
will be blank for the particular event. 

4.4.4 3 - Follow-ups Group Box 
Use the 3 – Follow-ups group box to add follow-up data about the event. 

 
Figure 4-23: Follow-ups group box 

The Follow-ups group box becomes active when the Follow-up Recommended field 
(in the Findings group box) is set to Yes. 

You can minimize this group box by clicking the collapse button in the upper left 
corner. This allows more room for viewing the other group box (Patient 
Notifications). 
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Follow-up Decision Due By: select a date from the drop-down list that indicates 
when the follow-up decision should be made. Populating the field creates a tickler 
(feather icon) for the event. In certain cases, this date is populated by the Tickler 
Timeframe set in the site parameters. You can populate this field with the date you 
want to take action on the event. 

4.4.4.1 Add Button 
Use the Add button to create a new Follow-up record. Click the Add button (or press 
the F2 button on your keyboard) to access the Follow-Ups dialog. 

 
Figure 4-24: Sample Follow-Ups dialog 

The required fields are those with the asterisk after the name. 

Event: select an option from the drop-down list that describes the Event for the 
follow-up. 

Date Due: use the drop-down list to display a calendar from which to select the due 
date for the follow-up event. 

Comment: use this Free Text field to add comments about the follow-up. 

Click OK to save the data on the dialog (otherwise, click Cancel). After saving, the 
follow-up record will display in the 3 - Follow-ups group box on the CMET 
Worksheet. 

4.4.4.2 Delete Button 
The Delete function applies to events that had Follow-ups entered but NOT saved. 

Select one or more eligible Follow-up records you want to delete and then click the 
Delete button (or press the Delete button on your keyboard). The application displays 
the Delete Row information message, confirming the deletion. Click Yes to delete the 
selected records. Click No to not delete the records. 
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4.4.4.3 Error Button 
Use the Error button when Follow-up records have been saved and you cannot delete 
them and you want to mark them as Entered in Error. 

If you select a record that is not eligible for the Error button, the application displays 
the message: Unable to mark as ‘Entered in Error’ because the entry has not been 
saved in RPMS. Please delete the entry instead. Click OK to dismiss the message. 

Select one or more eligible Follow-up records and click the Error button. After using 
this function, the application places a strikethrough mark on the text of the record. 

 
Figure 4-25: Sample of Follow-up record marked as entered in error 

4.4.5 4 - Patient Notifications Group Box 
Use the 4 – Patient Notifications group box to add patient notification data about the 
event. 

 
Figure 4-26: Patient Notifications group box 

The Patient Notification, the final step, makes the patient aware of both the results 
and the recommendations for follow-up. Multiple types of Patient Notifications can 
be entered for each Event. 

The Patient Notifications group box becomes active when a finding is entered in the 
Findings group box. 

You can minimize this group box by clicking the collapse button in the upper left 
corner. This allows more room for viewing the Follow-ups group box. 

Notification Due By: enter the date to have your patient notified about the results and 
recommendations of the follow-up related to this event. If this date passes without an 
entry, a tickler (feather) icon will be generated. In certain cases, this date is populated 
by the Tickler Timeframe set in the site parameters. 
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4.4.5.1 Add Button 
If you do not have default clinics defined in user preferences, the application displays 
the following message: You must select default clinics in user preferences before 
being able to enter notes. Click OK to dismiss the message. Select Tools | User 
Preferences to access the RPMS iCare – User Preferences dialog. Go to the 
Patient View tab to enter the clinic codes. 

Use the Add button to create a new Patient Notification record. Click the Add button 
(or press the F2 button on your keyboard) to access the Notifications dialog. 

 
Figure 4-27: Sample initial Notifications dialog 

The required fields are those with the asterisk after the name. 

Date: the default date is today’s date. You can change it by clicking the drop-down 
list to access a calendar from which to select another date. 

Method: select an option from the drop-down list that identifies the type of 
notification. 

Create: this button becomes active if you select “Certified Letter” or “Letter” in the 
Method field. You must have an electronic signature on file before you can use this 
function. 

If you have an electronic signature on file, click the Create button to access the Add 
TIU Note dialog. 

Comment: use this Free Text field to add any comments about the notification. 

After completing this dialog, click OK to save the data (otherwise, click Cancel). 
After saving, the notification record will display in the 4 - Patient Notifications group 
box on the CMET Worksheet. 
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4.4.5.2 Delete Button 
The Delete function applies to events that had Patient Notifications entered but NOT 
saved. 

Select one or more eligible Patient Notification records you want to delete and click 
the Delete button (or press the Delete button on your keyboard). The application 
displays the Delete Row information message, confirming the deletion. Click Yes to 
delete the selected records. Click No to not delete the records. 

4.4.5.3 Error Button 
Use the Error button when Patient Notification records have been saved and you 
cannot delete them and you want to mark them as Entered in Error. 

If you select a record that is not eligible for the Error function, the application 
displays the message: Unable to mark as ‘Entered in Error’ because the entry has not 
been saved in RPMS. Please delete the entry instead. Click OK to dismiss the 
message. 

Select one or more eligible Patient Notification records and then click the Error 
button. After using this function, the application places a strikethrough mark on the 
text of the record. 

 
Figure 4-28: Sample Patient Notification record marked as entered in error 

4.4.5.4 Preview 
Use the Preview function to preview the letter associated with the selected Patient 
Notification record. This function only applies to records that are Letters or Certified 
Letters. 

Select the record you want to preview and then click the Preview button. The 
application displays the Letter Preview pop-up. 
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Figure 4-29: Sample Letter Preview pop-up 

4.4.5.5 Print Button 
Use the Print button to output a letter in a selected record. After clicking Print, the 
application displays the Print dialog where you specify the printer, page range, 
number of copies, etc.; this dialog works like the one in MS Office. 

4.5 Erroneously Tracked Events 
Once an event has been Tracked, it cannot be changed to Not Tracked. The following 
process is used when you erroneously Tracked an event. 

1. Go to the Tracked tab, in any view (Main, Panel, Patient Record) and open a 
CMET worksheet for the event you erroneously tracked. Click the Add button in 
the Findings area to access the Findings dialog. 

 
Figure 4-30: Sample Findings dialog populated 

Choose the option ERROR/DISREGARD in the Findings field. Choose the 
option No in the Follow-Up Needed? field. We suggest to use today’s date for 
the Date field. Click OK to save and to close the dialog. 
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2. Go to the Patient Notifications area of the CMET Worksheet and click the Add 
button. The application displays the Notifications dialog. 

 
Figure 4-31: Sample Notifications dialog populated 

Use the option NONE for the Method field. We recommend to add a comment in 
the Comment field and to use today’s date for the Date field. Click OK to save 
and to close the dialog. 

3. The application will display the Close Event information message. 

 
Figure 4-32: Close Event information message 

Click Yes on the message. This closes the message. 

4. The application will display the RPMS iCare – Reason for Closing dialog. 
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Figure 4-33: RPMS iCare – Reason for Closing dialog 

Select the option Other for the Reason field. Enter a comment in the Comment 
field. Click OK to save and to close the dialog. 

5. The application will display the Confirm save to RPMS information message. 

 
Figure 4-34: Confirm save to RPMS information message 

Click Yes on the message to save the data to RPMS and to close the message. 

This process causes the particular event to have a State of CLOSED. 

4.6 Using Create Button on Batch Processing Window 
If you are on the CMET Batch Mammogram Screening or CMET Batch Pap Smear 
window, click the Create button to access the Add TIU Note – Batch Mode dialog. 
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Figure 4-35: Sample Add TIU Note – Batch Mode dialog 

4.6.1.1 Fields 
Both fields are required. 

Document Title: select an option from the drop-down list to establish the title of the 
TIU note. 

Subject: use this Free Text field to enter the subject of the TIU note. 

At this point, you can do one of the following: not use a template (Section 4.7.1.1 
provides more information) or use a template (Section 4.7.1.2 provides more 
information). 

4.6.1.2 Buttons 
The Find, Font, Copy, Print Preview, and Print buttons on this dialog work like those 
on the pop-up window. 

You should adjust the Font size before saving the note. Using this process will save 
the note in an appropriate font size for output (later). 

Save Note: use this button to save the current note. 

Delete Note: use this button to delete the current unsigned note. (This button does not 
apply to signed notes.) 

Edit Note: use this button to edit the text of an unsigned note. 

Close: use this button to close the Add TIU Note – Batch Mode dialog. 

After you click the Close button, the application closes the Add TIU Note – Batch 
Mode dialog. 

Then the application displays the Enter Electronic Signature dialog. 
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Figure 4-36: Enter Electronic Signature dialog 

Enter your electronic signature in the field and then click OK (otherwise, click 
Cancel). 

4.6.1.3 Printing the TIU Note 
When you use OK (on the Enter Electronic Signature dialog), the application 
displays the Print TIU Notes information message. 

 
Figure 4-37: Print TIU Notes information message 

Click Yes to print the TUI note. The application displays the Print Preview dialog. 
You can print the TIU note from this dialog. 

Click No to not print the TUI note. The application displays the Print TIU Notes 
information message. This gives you a second time to print the TUI note. 

 
Figure 4-38: Print TIU Notes information message 

Click Yes to print the TIU note at this time when batch processing. Otherwise, you 
will only be able to reprint this note from the individual patient record. 

If you use Yes, the application displays the Print Preview dialog. You can print the 
TIU from this dialog. 
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4.7 Add TIU Note Dialog 
The following information provides information about using the Add TIU Note 
dialog. 

4.7.1 Using the Add a Note Button 
When you click the Add Note button, the application displays the Add a Note dialog. 

After clicking the Create button on the Add a Note dialog, the application displays 
the Add TIU Note dialog. 

 
Figure 4-39: Sample Add TIU Note dialog 

Both fields are required. 

Document Title: select an option from the drop-down list to establish the title of the 
TIU note. 

Subject: use this Free Text field to enter the subject of the TIU note. This field 
becomes active after populating the Document Title field. 

At this point, you can do one of the following: not use a template or use a template. 

4.7.1.1 Note with No Template 
When you do not want to use a template, and, after you populate the Document Title 
and Subject fields, you can type the text of the TIU note in Free Text area on the right 
side of the dialog. 

When the text is complete, the following buttons are active: Find, Font, Copy, Save 
Note, Sign Note, Close. Section 4.7.1.3 provides for more information. 

Below is an example of what happens after you click the Save Note button. 
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Figure 4-40: Sample Add TIU Note dialog with note information 

4.7.1.2 Note with Template 
After you populate the Document Title and Subject field, check the Show Template? 
check box. This action shows the available templates that you can use. (You will need 
to expand the Shared Templates option.) After you find the template you want to use, 
double-click on its name. The application will display the particular template. 
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Figure 4-41: Sample Template 

You can complete the template by using the buttons and check boxes on the template. 
What you use on the template determines the text of the TIU note. 

Use the Preview button (on the Template window) to “preview” the note, in its 
current state. 

 
Figure 4-42: Sample Preview of the TIU note 

What appears on the Template Preview pop-up determines what will be in the text of 
your TIU note. After you close (File | Close) the pop-up, you return to the Template 
window. 
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After you have completed the Template window, click OK (otherwise, click Cancel). 
The OK option returns you to the Add TIU dialog. 

4.7.1.3 Buttons on Add TIU Note Dialog 
Please note the following about the text of the TIU note:  

• Line lengths should be <80 columns (characters), otherwise, the line spacing 
on the finished TIU note will not format correctly. 

• The Find, Font, Copy, Print Preview, and Print buttons on this dialog work 
like those on the pop-up window. 

• You should adjust the font size before saving the TIU note, if needed. 
Delete Note: use this button to delete the current unsigned note. (This button does not 
apply to signed notes.) 

Save Note: use this button to save the current note. After clicking this button, the note 
is saved and the Delete Note and Edit Note buttons become active. 

Sign Note: use this button to electronically sign the selected unsigned TIU note. After 
clicking the Sign Note button (or selecting File | Sign Note), the application displays 
the Enter Electronic Signature dialog. 

 
Figure 4-43: Enter Electronic Signature dialog 

Enter your electronic signature in the Free Text field and then click OK (otherwise, 
click Cancel). After using OK, you return to the Add TIU Note dialog. The text of 
the note shows that the note has been electronically signed. 

 
Figure 4-44: Sample electronic signature noted on text of TIU note 

Edit Note: after you click the Edit Note button, the application displays the text of 
the note. 
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Figure 4-45: Example of text of the note 

After you edit the text of the note, you can use the Save Note button again. 

If you have already signed the TIU note, you cannot change the text; you can only 
view the text. 

Close: use this button to close the Add TIU Note (for patient) dialog. Click the Close 
button (or select File | Close) to close the dialog. 

You return to the Add a Note dialog, with the Preview button next to the Add Note 
field. 

 
Figure 4-46: Sample Add a Note dialog with Preview button 

Click the Preview button to display the text of the note. 



iCare Population Management GUI (BQI) Version 2.5 

CMET User Manual CMET Layout 
June 2016 

56 

 
Figure 4-47: Sample Letter Preview pop-up 

Close the pop-up to return to the Add a Note dialog (with the Preview button on it). 

After the Add a Note dialog is complete, click OK (otherwise, click Cancel). 

After clicking OK, the application displays the Enter Electronic Signature dialog. 

 
Figure 4-48: Enter Electronic Signature dialog 

Enter you electronic signature in the Free Text field. After completing the dialog, 
click OK (otherwise, click Cancel). 

• If you click OK and had entered an invalid electronic signature, the application 
displays the Invalid Attempt information message that states: Invalid electronic 
signature. Try again? Click Retry to return to the Enter Electronic Signature 
dialog. Click Cancel and the application displays the message: Unable to save 
with a signed note; click OK to return to the Add a Note dialog. 

• If you click Cancel, the application displays the message: Unable to save with a 
signed note. Click OK to dismiss the message. 

• If you click OK and had entered a valid electronic signature, the application 
displays the information message: This data will be saved to the RPMS server. Do 
you want to continue? Click Yes to save and to continue. Click No to not save and 
leave the dialog. 
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5.0 Menus on the CMET Tab 

5.1.1 File Menu 
The File menu has the following options: 

CMET: this shows various options depending on the sub-tab you are currently on. 

Change RPMS Server/Login: This option allows you to change your access and 
verify codes to the iCare application on the iCare 2.4 Login dialog. 

Change RPMS Division: This option allows you to change the RPMS Division on 
the Select Division dialog. This option applies to a site that uses more than one RPMS 
database. 

Recent Panels: This sub-menu shows your recent panels. If you select one, you can 
view the patients in the selected panel in a new window. The list of panels is the last 
five panels that you have viewed. 

Page Setup: This option allows you to set Margin, Paper, Layout characteristics (like 
landscape or portrait orientation), and the Printer to use. These settings are used when 
you use the Print option. 

Print Preview: This option displays the print preview dialog. 

Print: This option sends the selected rows in the grid to the printer using the settings 
in Page Setup. Note that only the selected tab will be printed. 

Background Jobs: This option displays the Background Jobs pop-up. This pop-up 
displays, for example, the start and end dates for the monthly and weekly background 
jobs. 

Exit iCare: The option allows you to leave the iCare application. You will be 
reminded to save any changed panels (if needed). 

Lock iCare: This option allows you to lock the iCare application. You resume with 
the application by entering your verify code on the iCare locked by dialog and 
clicking Resume. 

5.1.2 Tools Menu 
The options on the Tools menu are the same as those on the Tools menu for the Panel 
List window. 

Quick Patient Search: This option allows you to search for a patient name. This is 
the same as using the F8 key on your keyboard. 
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The Mail Merge, Reset View, Search, Refresh, Excel Export, Print, and Copy 
Rows to Clipboard options work like the buttons on the right side of the window. 

Manage Templates: This option takes you to the Template Management dialog 
where you manage your templates and public templates. 

User Preferences: This option opens the User Preferences window. 

View iCare Notifications: This option opens the iCare Notifications pop-up. 

iCare Package Manager: This option is active for those users with Package Manager 
security key. 

iCare Site Parameters: This option allows you to set site parameters for Employers, 
Pregnancy, Inactivity Time Out, CMET Site Parameters, IPC Site Parameters, 
Divisions, DM Audit. 

Taxonomy Maintenance: This option is used by those users who can maintain 
taxonomies. Also, you use this option to view the taxonomy elements. This option has 
the following two features: View/edit Taxonomies and Taxonomy User Access. 

Web Links: This option provides links to Web sites for related clinical guidelines. 

5.1.3 View Menu 
The option on the View menu is: 

Split View: When this option is checked, that means that the current view is the split 
view. You can change back to the CMET tab by removing the checkmark; this is a 
temporary setting. When you exit iCare and reopen iCare, the settings established in 
User Preferences are used for the default view. 
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6.0 iCare Features Used by CMET Main Window 
The following provides information about using the iCare features for the CMET 
main window. 

6.1 User Preferences 
This section focuses on the user preferences that are used by the CMET main 
window. 

 
Figure 6-1: Sample User Preferences window 

After the User Preferences window is complete, click OK and the user preferences 
will be in effect for the operation of the iCare application. (Otherwise, click Cancel.) 

6.1.1 Startup View Tab 
The selection on Startup View tab determines the tab that displays when you first 
access the iCare application. 
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Figure 6-2: Sample Startup View tab on User Preferences 

Select the CMET radio button if you want the CMET main window to be the first 
window to display when you access the iCare application. In addition, you must 
select the sub-tab to be displayed (Events is the default). Select an option from the 
drop-down list to change the sub-tab. 

6.1.2 Layouts Tab 
The Layouts tab on User Preferences determines the default Template used by the 
various CMET sub-tabs. 
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Figure 6-3: Layouts tab on User Preferences 

6.1.3 CMET Tab 
The CMET tab determines the Events, Tracked Events, and Follow-up Events user 
preferences for the Main View CMET window. 

 
Figure 6-4: Main View tab features 

After you change the settings on any of the three sub-tabs, click OK to save your 
changes (otherwise, click Cancel). 
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Return to System Default Button. 
Click the Return to System Default button to return to the system default settings. 
This button is available on all of the CMET sub-tabs. 

Collapse Tips Display 
Select the Collapse Filters Display check box to have the Tips of the particular sub-
tab in the collapsed state (you will not be able to view the various tips). This check 
box is available on all of the CMET sub-tabs. 

Collapse Filters Display 
Select the Collapse Filters Display check box to have the Filter group box of the 
particular sub-tab in the collapsed state (you will not be able to view the various 
filters). This check box is available on all of the CMET sub-tabs. 

Status 
Use the Status field to filter the displayed events to those having a particular status. 
Click the drop-down list and select an option to populate the Status field. The Status 
field is not available on the Follow-up Events sub-tab. 

Time Frame 
Use the Time Frame field to filter the displayed events to those in a particular time 
frame. Click the drop-down list and select an option to populate the Time Frame field. 
This field is available on all of the CMET sub-tabs. 

6.1.3.1 Events Sub-tab 
This information applies to the Events sub-tab for the CMET main view. 

 
Figure 6-5: Events sub-tab options for Main View 
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The Events sub-tab displays all events that have been identified at your site in the 
routine background job. This can be a very large number of events, but you can limit 
this display by applying filters to your view. Filtering in this manner does NOT affect 
the routine background job. 

Use the Events sub-tab to establish the filters for the current events on the CMET 
main window. 

Use the Tracked Events sub-tab to establish the filters for the tracked events on the 
CMET main window. 

Use the Follow-up Events sub-tab to establish the filters for the follow-up events on 
the CMET main window. 

All three sub-tab have the same features. 

6.1.3.1.1 Category 
Use the Category field to filter the displayed events to those in one or more 
categories. To populate the Category field, click the Edit button to access the 
Add/Remove Events Category dialog. The default Category field contains Breast, 
Cervical, Colon, Skeletal, STI. 

 
Figure 6-6: Sample Add/Remove Events Category dialog 

Available Selections 
Use the Find field to locate a particular event category name by using the two search 
radio buttons: Start With determines what the event category name starts with and 
Contains determines any of the characters in the event category name. These radio 
buttons assist you when the Available Selections list is quite long. 

To move a highlighted category name from the Available Selections list to the 
Current Selections list, click Add. 
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Current Selections 
Use the Find field to locate a particular event category by entering a dew characters 
of the event category name. The application will scroll the list to the first found name. 

To move a highlighted category name from the Current Selections list to the 
Available Selections list, click Remove. 

The options in the Current Selections field determines the default Category for the 
Events (Tracked Events, Follow-up Events) sub-tab on the CMET main window. 

6.1.3.1.2 Community 
Use the Community field to filter the displayed events to those in a community either 
by taxonomy or by name. 

 
Figure 6-7: Community filter fields 

Select one of the radio buttons to use as a filter for the events. 

By Name Radio Button 
Use the By Name radio button to define the communities to filter the events. 

Use the field below the radio buttons to filter the communities in the lower field. The 
options are (1) With At Least One Patient or (2) All. 

Use the Edit button to add one or more names to the lower field. Click the Edit 
button to access the Add/Remove Communities dialog. 
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Figure 6-8: Sample Add/Remove Communities dialog 

Available Selections 
The Available Selections option determines patient population for a community by 
name. Select an option from the drop-down list to change this field. 

Section 6.1.3.1.1 provides information on how to use the Available Selections and 
Current Selections group boxes. 

When the Add/Remove Communities dialog is complete, click OK and this 
populates the lower field with the names of the communities shown in the Current 
Selections group box. (Otherwise click Cancel.) 

If the lower field contains more than one community, this activates the Create 
Taxonomy button. To use the Create Taxonomy button, the user must have the iCare 
Editor (BQIZCMED) or iCare Package Manager (BQIZMGR) security key. 

 
Figure 6-9: Community group box with Create Taxonomy active 

Use the Create Taxonomy button to save the listed communities as a Community 
taxonomy. Click the Create Taxonomy button to display the Create/Update 
Community Taxonomy dialog. 
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Figure 6-10: Create/Update Community Taxonomy dialog 

Use the Community Taxonomy Name field (required) to specify a taxonomy name 
for the list of communities. Use the Brief Description and Extended Description 
fields (not required) to add other information about the taxonomy. When the dialog is 
complete, click OK (otherwise, click Cancel). 

If the user uses a duplicate taxonomy name, iCare will provide a warning that the user 
might be overwriting the user’s taxonomy. The user can overwrite (Yes), save as 
another name (No), or cancel (to return to the Create/Update Community Taxonomy 
dialog). 

If you use a unique taxonomy name, the application displays the “Confirm save to 
RPMS” information message that asks: The data will be saved to the RPMS server. 
Do you want to continue? Click Yes to save the data to the RPMS server (otherwise 
click No). If you click Yes, the application displays the Community Taxonomy 
Create message stating that the community taxonomy was successfully created and 
that the panel definition will be updated to reflect the use of a taxonomy rather than a 
list of communities. (Click OK to dismiss the message). After you click OK, the list 
of names will be replaced with the name of the taxonomy (and the By Taxonomy 
radio button will be selected). 

By Taxonomy Radio Button 
Use the By Taxonomy radio button to define the taxonomies to filter the displayed 
events. When you click the Edit button, the application displays the Add/Remove 
Community Taxonomies dialog. 
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Figure 6-11: Add/Remove Community Taxonomies dialog 

Section 6.1.3.1.1 provides information on how to use the Available Selections and 
Current Selections group boxes. 

When the Add/Remove Community Taxonomies dialog is complete, click OK. The 
options in the Current Selections group box determine the default Community by 
Taxonomy for the Events on the CMET main window. (Otherwise click Cancel.) 

6.2 Free Text Fields 
Free text fields are those fields that you can type information into; those types of 
fields do not have a drop-down list from which to select an option to populate it. 

An example of the Free Text field is the Panel Name field (when creating/editing a 
panel definition). 

There is a context menu to aid in editing the text. 

 
Figure 6-12: Context menu to aid in editing text 

These options operate just like those in any Windows application. 

Undo: removes the last edit action. 

Cut: removes the selected text from its current position and places it on the Windows 
clipboard. 
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Copy: copies the selected text and places it on the Windows clipboard (the text is 
NOT removed). 

Paste: copies the contents of the Windows clipboard and places it in the field at the 
current cursor position. 

Delete: removes the selected text from its current position. 

Select All: highlights all of the text in the current field. 

6.3 Print Preview 
The Print Preview window contains several features about reviewing and printing the 
current document. 

 
Figure 6-13: Sample Print Preview dialog 

The Print Preview window contains two panels, where the left panel displays the 
pages in the document and the right panel displays a larger version of the page 
selected in the left panel. 

The following table provides information about the various buttons on the Print 
Preview window. 

Button Description 

 
Used to output the contents of the document. 
Also available by selecting Print option on the File menu. 
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Button Description 

 
Used to move the red rectangular box on the selected page in the left panel. 
As you move the Hand Tool, this changes the display in the right panel. This 
is used to view information in a particular part of a page. 
Also available by selecting the Hand Tool option on the Tools menu. 

 
Used to get a screen capture of a specified rectangular area. This screen 
capture copies the area to the Windows clipboard. Then you can paste the 
copy in a particular field, for example, or another application like MS Word. 
Also available by selecting the Snapshot Tools option on the Tools menu. 

 
Used to specify the zoom magnification. Click the button and then move to 
the area where you want to apply to zoom. Right-click on the area and select 
the zoom magnification option from the context menu. 
Also available by selecting the Dynamic Zoom Tool option on the Tools 
menu. 

 
Used to zoom out by clicking the button in an area in the right panel (the 
image becomes smaller). 
Also available by selecting the Zoom Out option on the View menu. 

 
Used to zoom in by clicking the button in an area in the right panel (the image 
becomes larger). 
Also available by selecting the Zoom In option on the View menu. 

 
Used to cause the image in the right panel to display to its maximum page 
width (usually enlarges the image). 
Also available by selecting the Page Width option on the View menu. 

 
Used to cause the image in the right panel to display the image with no page 
margins showing. 
Also available by selecting the Margin Width option on the View menu. 

 Used to display the image and its page margins in the right panel. 
Also available by selecting the Whole Page option on the View menu. 

 
Used to automatically cause the image in the right panel to zoom out (you do 
not click in the panel). 
Also available by selecting the Zoom Out on the View menu. 

 
Used to automatically cause the image in the right panel to zoom in (you do 
not click in the panel). 
Also available by selecting the Zoom In on the View menu. 

 Used to cause all of the pages to display in the right panel. 
Also available by selecting the Continuous option on the View menu. 

 
Used to specify the page layout. 
Also available by selecting the Page Setup option on the File menu. 

 
You move through the pages in the document by using the arrow buttons on the 
second line in the toolbar. 

 
Figure 6-14: Buttons used to move through the pages of the document 
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The same options are available by selecting View | Go To (and on the context menu 
for the right panel). 

Use the Zoom  field (or select the Zoom option on the View menu) 
to specify the zoom magnification for the right panel by selecting from the drop-down 
list. 

Use the Close button to close the Print Preview dialog. This same action is available 
by selecting File | Exit. 

Select File | Page Setup to access the Page Setup dialog. 

 
Figure 6-15: Sample Page Setup dialog 

Use the Paper group box to specify the paper size and source. 

Use the Orientation group box to specify the orientation of the output. 

Use the Margins (inches) group box to specify the various margins widths in inches. 

Click Printer to access the Printer dialog where you choose the printer to output the 
contents of the document. 

After the Page Setup dialog is complete, click OK to save the page setup options. 
(Otherwise, click Cancel.) 
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6.4 iCare Package Manager Functions 
When you have the Package Manager security key, you can access the functions by 
selecting Tools | iCare Package Manager on the iCare main window. 

 
Figure 6-16: iCare Package Manager Functions 

6.4.1 iCare User Access Management 
The iCare User Access Management option accesses iCare User Access 
Management dialog. 

When this dialog is complete, click OK to save your changes. (Otherwise, click 
Cancel.) 

 
Figure 6-17: Sample iCare User Access Management dialog 

For those with the appropriate permissions, you can assign roles to a particular user, 
scroll to the name on the iCare User Access Maintenance dialog and select the 
appropriate check boxes for the roles. If you want to remove an assigned role, de-
select the particular check box.  

Note: The BH User column cannot be changed. 

Each column heading has hover help. 

Some check boxes are checked and the background is dark: 

If the user has iCare Package Manager access that supersedes both CMET and Editor 
permissions. The Employer and BH ones work differently due to the sensitive nature 
of the patients involved. 
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6.4.1.1 Existing RPMS Editor Access 
The users displayed on this list (those with the iCare user icon ( ) in first column) 
have been given existing Editor or Manager level key(s) to at least one of the 
following case management applications: (1) Case Management System (ACM), (2) 
Diabetes Management System (BDM), (3) HIV Management System (BKM), (4) 
Immunization (BI), (5) Patient Chart Problem List, and/or (6) Women’s Health (BW). 

6.4.1.2 Help Menu 
Click the Help menu to view the following information: 

The users displayed on this list have been given basic access to the iCare application 
by your Site (IT) Manager. You cannot give Editor or Package Manager access to 
iCare to a user who does not have basic access. See your Site Manager to require 
basic iCare access for other users. 

This message applies to the “User with iCare Access” column. Click OK to dismiss 
the message. 

6.4.1.3 Users with iCare Access 
This column is a list of RPMS users who have been given access to the iCare 
application by the Site (IT) Manager. 

6.4.1.4 iCare Package Manager 
The iCare Package Manager has all read/write access as defined for other user levels. 
This person can do the following: 

• Assign all other access roles in iCare: iCare Package Managers; CMET Package 
Managers; Editors; and Taxonomy Editors. 

• Access Patient Information associated with Community Alerts. 

• Has all read/write access as defined for other user levels. 

• Reassign existing iCare panels to iCare users. 

Note: Taxonomy Editor Access Management is assigned through 
the Taxonomy Maintenance/ Taxonomy User Access 
Window from the Tools Menu. 

The iCare Package Manager has the highest level of permissions; hence, the iCare 
Package Manager will have access to all items accessible by the CMET Package 
Manager. 
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The iCare Package Manager does everything an editor does and also has the ability to 
access the list of patients who has triggered the Community Alerts. This person also 
assigns Editor access to other users. In addition, this person can assign the CMET 
Package Manager role. 

6.4.1.5 CMET Package Manager 
The CMET Package Manager has the ability to establish the CMET site parameters 
related to Tickler Timeframes and Batch Processing. CMET Package Managers have 
all read/write access as defined for other user levels. 

6.4.1.6 Editors 
Editors in iCare will have read/write access to: (1) PCC Historical Data Entry, (2) 
Care Management data, (3) Family History and Reproductive Factors (Snapshot), (4) 
Designated Specialty Provider Management system (DSPM), (5) Problem List, and 6) 
CMET Worksheet. 

The Editor role grants the right to edit the care management function (e.g., HMS Care 
Management) and allows Historical Data entry. 

6.4.1.7 Employer Group Access 
Employer Group Access gives the user the ability to define a panel based on the 
“Employer” option in Panel Definition. They will also have visibility for the 
“Employee Health” option on the Panel View: Care Mgmt tab. Both the definition 
and Care Mgmt feature will not be visible to users who do not have permission. 

6.4.1.8 BH Alerts 
Exclude non-BH alerts. 

6.4.1.9 BH User 
User with existing BH access. This cannot be edited from iCare screens. 

6.4.1.10 IPC Package Manager 
The IPC Package Manager has the ability to establish site parameters related to the 
background job and microsystem definition for IPC tabs in iCare. 

6.4.2 Reassign Panels 
The Reassign Panels option displays the Reassign Panels dialog. 
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Figure 6-18: Reassign Panels Dialog 

This dialog allows the iCare Package Manager to reassign panels from one user to 
another user. 

Reassign From: select the user from the drop-down list, whose panels you want to 
reassign. 

Reassign To: select the user from the drop-down list, to whom the panels are to be 
reassigned. 

Populating the first two fields activates the Select button. Click Select to access the 
Add/Remove Panels dialog. 

 
Figure 6-19: Sample Add/Remove Panels dialog 

After the Add/Remove dialog is complete, click OK and the panels listed in the 
Current Panels group box will populate the Panels field on the Reassign dialog. 
(Otherwise, click Cancel). 

After the Reassign Panels dialog is complete, click OK and the reassigned panels of 
the “Reassign From” user are removed from that person’s panel view. The reassigned 
panels will appear in the “Reassign To” user panel view. (Otherwise, click Cancel.) 
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6.5 iCare Taxonomy View/Edit 
The iCare Taxonomy Editor holds the security key (BQIZTXED) allowing that 
person to read/edit iCare taxonomies. 

You access the iCare Taxonomy View/Edit dialog by either selecting Tools | 
Taxonomy Maintenance | View/Edit Taxonomy Entries (on the main iCare Tools 
menu). 

 
Figure 6-20: Sample iCare Taxonomy View/Edit dialog 

Note: If you do not hold that security key, you can only view the 
information on the dialog. The following information 
displays: You do not currently have access rights to edit 
taxonomies. In order to edit taxonomy entries, you will 
need to have the iCare Taxonomy Editor security key 
(BQIZTXED) added to your RPMS user account. 

When you first access this view/edit dialog, all parts of the tree structure will be 
collapsed. You need to expand one of the tree parts and find the taxonomy you want 
to edit. 

In general, select the taxonomy from the list in the left group box that you want to 
view. This causes the Add and Remove buttons to appear in the right group box of 
the dialog. 
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Please note that not all taxonomies can be edited. iCare will display a message on the 
view/edit dialog when this condition exists. Site populated taxonomies can only be 
edited by users with appropriate access. 

The difference between the Apply and OK is: the Apply button is used when you add 
more than one taxonomy value to the iCare Taxonomy View/Edit dialog. 

6.5.1 Add Taxonomy Values 
Click the Add button to create values for a selected item in the left group box. The 
application displays the Select Taxonomy Item dialog. 

 
Figure 6-21: Select Taxonomy Item dialog 

Use the Search field to search for a taxonomy item. Highlight the item you want to 
add and click Select. The application checks to see if it is already there. 

• If it already exists, you receive a warning message about that (click OK to 
dismiss the message); after clicking OK, you return to the iCare Taxonomy 
View/Edit dialog. 

• If it does not exist, it appends the selected item to the bottom of the list. 
After you finish adding taxonomy values, click Apply to “save” your changes. If you 
do NOT click Apply and try to move to another taxonomy or another part of the 
iCare application, the Save Taxonomy changes? information message displays, 
asking if you want to apply the changes now. In this case, click Yes to apply the 
changes (otherwise, click No). 

You can repeat adding items to various taxonomies. When you are finished using the 
iCare Taxonomy View/Edit dialog, click OK to save (otherwise, click Cancel). 
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6.5.2 Remove Taxonomy Values 
If you want to remove one or more items from the list, highlight them and click 
Remove. The Confirm taxonomy item remove message displays. Click Yes to 
remove the items (otherwise, click No). You remain on the iCare Taxonomy 
View/Edit dialog. 

6.5.3 View Report of All Taxonomies Button 
Click the View Report of All Taxonomies button to display the Taxonomy Report 
pop-up. 

 
Figure 6-22: Taxonomy Report 

This pop-up provides information about various Taxonomy Categories (listed in 
alphabetical order). 

See Section 6.6 for information about the File menu and buttons on the pop-up. 

6.6 Pop-up Functionality 
Several places in iCare you will be viewing a pop-up. For example, if you double-
click on any row in the Recent Visits group box on the Cover Sheet of the Patient 
Record window, you will view a pop-up. 
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Figure 6-23: Sample Visit Detail pop-up 

You can take the following actions on this pop-up: 

• Navigate through the information by using the scroll bar. 

• Click the Find ( ) button to access a search tool to find data in the current 
window. This button works like the Search button. 

• Click the Font ( ) button to display the Font dialog. 

 
Figure 6-24: Font dialog 

Here you can change the Font name, style, and size of the text in the pop-up 
(applies to all of the text). In addition, you can add effects like Strikeout and 
Underline - these perform like those effects indicated in MS Word. 
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Change the Script option if you need to the see the text displayed in another 
language and you have that language pack installed on your computer. If the 
language pack is not installed, the display does not change by selecting another 
script. 

Click OK to apply your changes to the text in the current pop-up. These changes 
are only effective for the current view of the pop-up. (Otherwise, click Cancel.) 

• Click the Copy ( ) button to copy the selected text to the Windows 
clipboard. 

• Click the Print Preview ( ) button to view the Print Preview dialog. 
You can print the contents of the pop-up from this dialog. 

• Click the Print ( ) button to display a print dialog where you specify the 
printer to output the contents of the pop-up, the page range, and number of 
copies. 

The File menu contains the print actions (like the Print Preview and Print buttons), 
the Page Setup function, the find and copy functions, as well as a Close function 
(dismisses the pop-up). 

6.7 Taxonomy User Access 
Editing site populated taxonomies can affect many existing processes in RPMS. For 
this reason, Taxonomy Edit access is carefully assigned to a limited number of users 
and only after discussion with the CRS (GPRA) coordinator. 

Select Tools | Taxonomy Maintenance | Taxonomy User Access to access the 
iCare Taxonomy User Access Management dialog. 
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Figure 6-25: iCare Taxonomy User Access Management for Taxonomy Editor 

Each of the column headings has hover help. 

6.7.1 Existing RPMS Editor Access 
The users with the iCare user icon ( ) in first column are RPMS users with existing 
Manager level keys to at least one of the following applications: CRS (BGP), 
Diabetes Management (BDM), HIV Management System (BKM), and/or Women’s 
Health (BW). 

6.7.2 Users with iCare Access 
This column is a list of RPMS users who have been given access to the iCare 
application by the Site (IT) Manager. 

6.7.3 Taxonomy Editor 
Those with a checkmark are taxonomy editors who can add and delete members from 
any Site Populated Taxonomies related to either laboratory tests or medications. 

6.7.4 Help Menu 
The following information displays when you click the Help menu: 
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The users displayed on this list have been given basic access to the iCare application 
by your Site (IT) Manager. You cannot give Editor or Package Manager access to 
iCare to a user who doesn’t have basic access. See your Site Manager to require basic 
iCare access for other users. 

6.8 Change RPMS Server/Login 
The Change RPMS Server/Login option appears on the File menu. Select this 
option to access the iCare 2.4 Login dialog. 

 
Figure 6-26: Sample iCare 2.4 Login dialog 

RPMS Server 

Click the drop-down list to access the RPMS Server Management dialog that 
displays a list of possible connections. 

 
Figure 6-27: Sample RPMS Server Connection Management dialog 

Select an option on the grid or use the New function to create a new connection. 

Click New to access the Edit RPMS Server Connection dialog. 
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Figure 6-28: Edit RPMS Server Connection dialog 

Do not select the Default RPMS Server Connection or Use Windows 
Authentication check boxes. 

Connection Name 

Type the name of the connection in this field. This is the name that will appear on the 
RPMS Server Connection management dialog. 

Server Address/Name 

Type the number, including punctuation, of the server’s IP address. An IP address is 
typically four groups of two or three numbers, separated by a period (.), e.g., 
161.223.99.999. Your Site Manager will provide this information. 

Server Port 

Type the number of the server port. Your Site Manager will provide this information. 

Server Namespace 

If your site has multiple databases on one server, you will additionally need to type 
the namespace, which is typically a text string, e.g., DEVEH. 

Use default namespace 

Select this check box if the Server Namespace is the default one you want to use. 

After completing the fields, the Test Connection button becomes active. Click this 
button to access the Test Login dialog. Populate the Access Code and Verify Code 
fields and then click OK. 
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• After clicking OK, if the connection is correct, the application display the 
Connection Test message that states: RPMS login was successful. Click OK to 
dismiss the message. 

• Otherwise, the application will display an error message; click OK to return to the 
Test Login dialog. 

After the Edit RPMS Server Connection dialog is complete, click OK to have the 
server connection appear on the RPMS Server Connection Management dialog. 
Otherwise, click Cancel. 

After the RPMS Server Connection Management dialog is complete, click Save 
(otherwise, click Cancel). 

After clicking Save, the application displays the login dialog to the application. 

6.9 iCare Site Parameter Options 
You access the iCare Site Parameters on the Tools menu. 

 
Figure 6-29: iCare Site Parameter options 

6.9.1 CMET Site Parameters 
Use the CMET Site Parameters option to determine the tickler timeframes and batch 
processing for CMET. Select the CMET Site Parameters option to access the 
RPMS iCare – CMET Site Parameters dialog. 
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Figure 6-30: Sample RPMS iCare – CMET Site Parameters dialog 

Tickler Timeframes 
The Tickler Timeframes tab sets the ticklers (like reminder notices) for Findings, 
Follow-up Decision, and Patient Notification. 

Each field has a drop-down list from which to select an option. When a timeframe 
date is passed and the step has not been entered, the Tickler will be displayed. 

After you change one or more settings and click OK and the application populates the 
Last Edited field with the date, and the By field with the person who changed the 
tickler timeframe data. (Otherwise, click Cancel.) 

The application provides Ticklers designed to remind the user that a CMET is tracked 
and requires attention. There are three types of Ticklers: 

• Finding Ticklers, based on the event date. The Tickler is initiated from the date of 
the event. 

• Follow-up Decision Ticklers. Ticklers are initiated from the date the Findings 
were entered. 

• Patient Notification Tickers. Ticklers are initiated from the date the Follow-up 
recommendation is entered. 

Timeframes for each of the three steps is based on the preceding step. For example, a 
Follow-up Decision Tickler is based on the date the Finding was entered. 
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Batch Processing Tab 
The Batch Processing tab sets the timeframe and notification type for the Pap Smear 
and Mammogram Screening events with normal results. In addition, you can set the 
type of Normal Finding for the Mammogram Screening event. 

 
Figure 6-31: Sample Batch Processing tab 

The Notification Type field defines how the patient will be notified about the Pap 
Smear or Mammogram Screening, for example, by telephone. The default is 
LETTER. 

The Timeframe consideration is based on typical (or average) length of time it would 
take to receive results, to consider the next steps, and to notify the patient. 

The option selected for the Normal Finding for Mammogram Screening field 
determine what is a “normal” finding. 

Each field has a drop-down list from which to select an option. 

After you change one or more settings and click OK and the application populates the 
Last Edited field with the date, and the By field with the person who changed the 
batch processing data. (Otherwise, click Cancel.) 

6.10 Manage Templates 
The Manage Templates option provides a means for defining multiple template 
layouts. Templates can also be created and added so that anyone can download and 
use them. 
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The Manage Templates option appears on the Tools menu. Select it to access the 
Template Management dialog. 

 
Figure 6-32: Sample Template Management dialog 

The Your Templates group box contains a list of all of a specific user’s defined 
templates and the layout contained in each template. 

The Public Templates group box contains a list of all templates at the site that are 
available to be downloaded to the list in Your Templates. 

6.10.1 View 
Use the View action to view a selected template. This is a view-only display. 

6.10.2 Upload 
The Upload action is available in the Your Template group box. Select a template to 
upload and then click Upload. The selected template will appear in the Public 
Templates group box. The author will be you (the person who executed the Upload). 

6.10.3 Download 
The Download action is available in the Public Templates group box. Select a record 
to download and then click Download. The selected template will appear in the Your 
Templates group box. In the Template field, your name (the person who executed 
the Download) will appear after the name of the template. 
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6.10.4 Delete 
The Delete action is available in the Your Templates and Public Templates group 
boxes and applies to your templates only. Select a record to delete and then click 
Delete. The Delete Template information message displays confirming the deletion. 
Click Yes to delete (otherwise, click No.) 

6.10.5 Edit 
The Edit action is available in the Your Templates group box. Select a template to 
edit and then click Edit. You access the template of columns for the selected 
template. Section 6.10.6.1 provides information about how to use this template. 

6.10.6 Add 
The Add action is available in the Your Templates group box. Click Add to access 
the Add Template dialog. 

 
Figure 6-33: Add Template dialog 

Layout: Select an option on the Layout drop-down list to specify the layout to be 
used for the new template. 

After populating the Layout field, the Template Name field appears. 

 
Figure 6-34: Add Template dialog with added field 

Template Name: Type the name of the template in this Free Text field, limited to 80 
characters and must contain at least 1 alpha character. 
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After the dialog is complete, click Add to access the template to define the columns 
and their sorts for your new template. (Otherwise, click Exit.) 

 
Figure 6-35: Sample template for new template created 

Click the Reset to System Default button to cause the template to reset to the system 
default. 

If you changed several things about the columns on the template and you want to 
“undo” those changes, click Reset. 

After the template window is complete, click OK and the “new” template will appear 
in the Your Templates group box. (Otherwise, click Cancel.) 

6.10.6.1 Display and Available Columns 
Use the Display Columns to determine what columns you want to display for the 
particular window or tab. 
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Figure 6-36: Sample Display and Available columns 

The listing in the Display Columns area shows the columns that will be displayed for 
your template. The column names in italics are required and cannot be removed. 

To move a highlighted column name in the Available Columns area to the list in the 
Display Columns area, click Add. This moves the column name from the left panel 
to right panel. 

Likewise, you can remove a highlighted column name in the Display Columns area 
and move it to the Available Columns area by clicking Remove. This moves the 
column name from the right panel to the left panel. 

Note: You cannot remove any column names in italics. 

You can determine the order the columns display in the Display Columns area by 
using the Up and Down buttons. Highlight a column name and click the appropriate 
button. You might have to click the button more than once to move it to the desired 
location. 

6.10.6.2 Columns to Sort 
Sorting a column means you want to arrange the items in the column in alpha-
numeric order. 

 
Figure 6-37: Sample Available Sorts and Sort Columns area 
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To move a highlighted column name in the Available Sorts area to the list in the Sort 
Columns area, click Add. This moves the column name from the left panel to right 
panel. 

Likewise, you can remove a highlighted column in the Sort Columns area and move 
it to the Available Sorts area by clicking Remove. This moves the column name 
from the right panel to the left panel. 

Note: You cannot remove any column names in italics. 

6.10.6.3 Column Sort Order 
You use the Sort Columns area to determine what columns you want to sort for the 
particular window or tab. 

You determine which order the columns are sorted in the Sort Columns area by 
using the Up and Down buttons. Highlight a column name and click the appropriate 
button. You might have to click the button more than once to move it to the desired 
location. For example, if you have Gender, Patient Name, and Diagnosis Tags in the 
right column, the Gender sort is applied first then the Patient Name and then the 
Diagnosis Tags is last. 

6.10.6.4 Switch Sort Direction 
The names of columns in the Sort Columns area show “ASC” appended to the name, 
for example Patient Name ASC. You can switch the sort order for a selected column 
by clicking the Switch Sort Direction button. In the example, the name changes to 
Patient Name DESC. You can use the “switch sort direction” action on more than one 
column. 
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Glossary 

Context Menu 
The menu of options that displays when you right-click on an entity. 

Designated Primary Care Provider (DPCP) 
In RPMS, the provider name that is assigned as the primary care physician for 
a patient or group of patients at a specific facility. This is not a required 
function. 

Free Text Field 
A field where the user can type text, just like typing a note to someone. 

iCare Package Manager 
The designated person with authority to manage all information settings for 
iCare. 

Providers 
Any staff member in an I/T/U facility who provides direct healthcare to 
patients, e.g. general practice or specialty physicians, registered nurses, social 
workers, physician assistants, etc. 

Taxonomy 
In RPMS, a grouping of functionally related data elements, such as ICD 
codes, that are created and maintained within the RPMS Taxonomy Setup 
application. Taxonomies will be used as definitions for diagnoses, procedures, 
lab tests, medications, and other clinical data types. 

If you need a change or addition to an existing taxonomy, please see your 
CRS coordinator. 

Tooltip/Hover Help 
A common GUI element used to provide additional information to users. To 
display a Tooltip, hover the mouse pointer, without clicking, over a column 
heading or field. 
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Acronym List 

Acronym Term Meaning 
BQI Namespace for iCare 

CQM Clinical Quality Measures 

GUI Graphical User Interface 

HHS Health and Human Services 

IHS Indian Health Service 

IPC Improving Patient Care 

OIT Office of Information Technology 

PM Performance Measures 

RPMS Resource and Patient Management System 
 



iCare Population Management GUI (BQI) Version 2.5 

CMET User Manual Contact Information 
June 2016 

93 

Contact Information 

If you have any questions or comments regarding this distribution, please contact the 
OIT Help Desk (IHS). 

Phone: (888) 830-7280 (toll free) 

Web: http://www.ihs.gov/helpdesk/ 

Email: support@ihs.gov 

http://www.ihs.gov/helpdesk/
mailto:support@ihs.gov
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